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1 JOHDANTO

Nykypäivän tekniikka mahdollistaa valokuvien korkealaatuisen toistamisen painettuna. 
Samalla myös vaatimukset lopputuloksen laadusta ovat kasvaneet ja tulevat varmas-
ti kasvamaan jatkossakin. Tekniikan kehittyminen on tuonut mukanaan helpotuksia, 
mutta toisaalta myös uusia haasteita. Haasteellisiin asioihin voidaan lukea esimerkiksi 
värien optimaalinen toistuvuus. Tässä opinnäytetyössä käyn läpi niitä asioita ja toimen-
piteitä joihin painoon toimitettavan digitaalisen valokuvan värinhallitussa työnkulussa 
tulee kiinnittää huomiota, eli asioita, joilla pyritään varmistamaan valokuvan värien 
toivottu lopputulos painettuna. Näiden asioiden lisäksi käsittelen syitä siihen, miksi niin 
tehdään.

Työ voidaan jakaa kahteen osaan. Alkuosassa asioita käsitellään teoreettisemmalla 
tasolla kuin loppuosassa, joka sisältää käytännön esimerkkejä. Teoreettisempi osuus 
alkaa luvusta 2, jossa käsitellään väriä yleensä; mitä se on ja miten se muodostuu. 
Kahdessa seuraavassa luvussa teoria liittyy graafisen työnkulun väreihin. Näissä kah-
dessa luvussa käsitellään RGB- ja CMYK-värien muodostuminen, sekä esitellään muita 
värijärjestelmiä, kuten HEX, Pantone, CIEXYZ ja CIELAB. Viimeinen varsinaiseksi teoria-
luvuksi laskettava luku esittelee värinhallintaa, sen historiaa ja osatekijöitä.

Käytännöllisempi osuus sisältää esimerkkejä näytön kalibroinnista ja profiloinnista, va-
lokuvauksesta sekä Adobe Photoshopin ja Indesignin väriasetuksista. Näytön kalibrointi 
ja profilointi käydään läpi vaihe vaiheelta luvussa 6 esimerkkikuvin ja kuvatekstein. 
Valokuvausta käsitellään luvussa 7. Seuraavat luvut esittelevät värinhallintaa Adobe 
Photoshopissa sekä Indesignissa. Näiden kahden sovelluksen väriasetukset käydään 
läpi luvussa 8 ja 9. luku koostuu esimerkeistä, kuinka valokuvan värejä säädetään väri-
kohteen avulla. Luvun 9 rakenne on samantyylinen kuin luvun 6. Lopuksi käydään läpi, 
miten valmis materiaali toimitetaan painoon.

Käytännöllisemmässä osassa esiteltyjen toimenpiteiden hallittu toteuttaminen, sekä 
ymmärtäminen miksi jokin asia tehdään niinkuin se tehdään, vaatii syventymistä alku-
osan teoriaan.
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2 mitä väri on?

Väri on tapahtuma, jossa on aina kolme osapuolta; lähde, kohde ja havainnoija (Kuva 
1). Jos yksikin osatekijä muuttuu, muuttuu myös väritapahtuma. Tämä tarkoittaa siis 
sitä, että nähdään eri väri. Väritapahtuma on sekoitus fysiikkaa, kemiaa ja biologiaa. 
(Fraser, Murphy & Bunting 2004, 5.) Seuraavissa kappaleissa käydään läpi väritapahtu-
man kolme osatekijää. 

2.1 Valo

Väritapahtuman ensimmäinen osatekijä on valo. Se mielletään yleensä kirkkaaksi ja 
värittömäksi. Valo ei kuitenkaan ole pelkästään sitä. Auringosta syntyvä ns. ei minkään 
värinen valo on itseasiassa summa koko näkyvän spektrin kirjosta, mutta kun siihen 
viitataan puhutaan valkoisesta valosta.

2.1.1 Fotoni

Jotta voitaisiin hahmottaa spektrin olemus, on ensin syytä käydä läpi termi fotoni. 
Fotoni-käsitteen loivat kvanttifyysikot, kuten Albert Einstein, yhdistämällä aalto- ja 
hiukkasmallin. Tehdyistä kokeista riippuen valo käyttäytyy toisinaan aallon, toisinaan 
hiukkasen tavoin. (Fraser ym. 2004, 6.)

Fotonin voi ajatella olevan tilassa liikkuva, sykkivä energiapaketti, jonka energiataso 
ei muuta sen liikenopeutta. Valon nopeus on kaikille fotoneille vakio, eli kaikki fotonit 
kulkevat saman matkan samassa ajassa (Kuva 2). Kukin fotoni syntyy ja kuolee tietyllä 
energiatasolla. (Fraser ym. 2004, 6.)

Kuva 1. Väritapahtuman kolme osapuolta (Fraser ym. 2004, 5)
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Fotonin energiataso määrittää sen värähtelytaajuuden. Taajuus kertoo aikayksikössä 
tapahtuvien värähdysten lukumäärän (Peltonen, Perkkiö & Vierinen 2004, 67). Mitä 
enemmän fotonissa on energiaa, sitä korkeampi on värähtelytaajuus; fotoni siis väräh-
telee nopeammin. Mitä korkeampi on värähtelytaajuus, sitä lyhyempi on aallonpituus. 
Kuvassa 2 on esitetty matalan ja korkean energiatason aaltoliike. (Fraser ym. 2004, 6.)

2.1.2 Spektri

Kun puhutaan spektristä viitataan usein näkyvän valon osuuteen spektrissä. Spektrillä 
kuitenkin tarkoitetaan koko sitä energiatasojen, toisin sanoen aallonpituuksien skaalaa, 
joilla fotonit liikkuvat tilassa ja ajassa (Fraser ym. 2004, 7). Koko spektrissä näkyvän 
valon osuus on kuitenkin kovin pieni, 385 –705 nanometriä (nm) (Johansson, Lundberg 
& Ryberg 2008, 108) (Kuva 3).

Kuva 2. Fotonin energiataso ei muuta sen liikenopeutta, kaikki fotonit kulkevat matkan pisteestä 

A pisteeseen B samassa ajassa

Kuva 3. Yläpuolella koko spektri, alapuolella silmän havaitsema osuus spektristä, eli näkyvä valo 

(Fraser ym. 2004, 7)
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Ihmissilmä reagoi ainoastaan tähän kapeaan osuuteen koko sähkömagneettisesta 
spektristä ja sen eri kohdat aiheuttavat erilaisia väriaistimuksia. Näkyvän valon pidem-
mät aallonpituudet aistimme punaisina ja lyhyemmät aallonpituudet sinisinä. (Fraser 
ym. 2004, 8.)

2.1.3 Valonlähteet

”Valonlähde on jokin, joka säteilee suuria määriä näkyvässä spektrissä sijaitsevia foto-
neita” (Fraser ym. 2004, 10). Seuraavassa on esitelty kaksi valonlähdetyyppiä. 

Mustilla säteilijöillä tarkoitetaan valonlähteitä, joiden kaikki säteily on peräisin läm-
pöenergiasta. Mustia säteilijöitä ovat esimerkiksi auringon kaltaiset tähdet sekä heh-
kulamppu, jonka valo on peräisin kuumennetusta volframihehkulangasta. Tunnetuin 
kaikista mustista säteilijöistä on aurinko, joka synnyttää päivänvalon. Päivänvalo on 
luultavasti tärkein kaikista valonlähteistä, sillä ihmisen näköjärjestelmä on kehittynyt 
sen alaisuudessa. (Fraser ym. 2004, 10-13.)

Mustat säteilijät antavat termin valon värin kuvaamiseen: värilämpötilan. Värilämpö-
tilaa kuvataan Kelvin-asteilla (K). Mustan säteilijän säteillessä matalilla lämpötiloilla, 
säteily on ihmissilmän näköalueen ulkopuolella infrapuna-alueella ja säteilyä kutsutaan 
lämmöksi. Kun lämpötila nousee noin 2000 Kelvin-asteeseen, näkyy ns. tulipunainen. 
Hehkulampulle ominaisen kellertävän värin antaa volframilangan toimiminen suunnil-
leen välillä 2850-3100 K. Korkeammilla lämpötiloilla, yli 9000 K, hallitsevat lyhyet aal-
lonpituudet, jolloin valon väri on sinertävä. (Fraser ym. 2004, 13.) Neutraalin valkoisen 
valon värilämpötila on noin 5000 K (Johansson ym. 2008, 73). 

Toinen valonlähderyhmä on sähköpurkauslamput, joiden toiminta perustuu suljetun 
putken sisällä olevien kaasuatomien energiatason nostamiseen sähkövarauksella. 
Loisteputkilamput ovat yleisin muoto sähköpurkauslampuista, joiden putken sisäpuoli 
on päällystetty fosforilla. Fosfori ”absorboi kaasun säteilemiä fotoneita ja säteilee ne 
takaisin eri aallonpituuksilla”. (Fraser ym. 2004, 11.) Tästä ilmiöstä, jossa tapahtuu 
valoenergian imeytyminen yhdellä ja emittoituminen eli luovuttaminen toisella aallonpi-
tuudella, käytetään nimitystä fluoresenssi (Fraser ym. 2004, 494).

2.2 Kohde

Väritapahtuman toinen tekijä on kohde. Kun valo 
törmää kohteeseen, se sukeltaa jonkin matkaa 
pinnalla olevien atomien sisään ja ilmestyy sen 
jälkeen takaisin esiin (Fraser ym. 2004, 13). Kun 

Kohde absorboi eli imee 
itseensä osan siihen 
törmäävästä valosta.
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fovea

verkkokalvo

sokea piste

näköhermo
mykiö

iiris

sarveiskalvo

näköakseli

valkoinen valo törmää esimerkiksi kuvan 1 omenaan, omena absorboi, eli imee itseensä 
aallonpituudeltaan lyhyttä valoa ja heijastaa aallonpituudeltaan pidempää valoa. Näin 
näemme omenan punaisena. Tämä tapahtuma on havainnollistettuna kuvassa 4.
 
Jos omenaan törmäisi ainoastaan aallonpituudeltaan lyhyttä, eli sinistä valoa, jonka 
omena absorboisi kokonaan, ei takaisinheijastumista tapahtuisi; omena ei näyttäisi 
punaiselta.

2.3 Silmän osuus värin havainnoimisessa

Väritapahtuman kolmesta osatekijästä kaikkein tärkein ja monimutkaisin tekijä on silmä 
(Kuva 5). Kaikkein tärkein silmän osa värin aistimisessa on verkkokalvo, joka sijaitsee 

Kuva 4. Valon heijastuminen omenasta (Fraser ym. 2004, 14)

Kuva 5. Ihmissilmän rakenne (Fraser ym. 2004, 17)
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silmän takaosassa. Verkkokalvolla on kahden tyyppisiä valoa 
vastaanottavia hermosoluja eli fotoreseptoreita; sauva- ja 
tappisoluja. Sauvasolut ovat herkkiä matalille energiatasoille ja 
mahdollistavat näin esimerkiksi pimeänäön. Tappisolut puo-
lestaan toimivat kirkkaasti valaistussa ympäristössä. Verkkokalvossa on kauttaaltaan 
paljon enemmän sauvasoluja kuin tappisoluja. Sauvasoluja on noin 120 miljoonaa ja 
tappisoluja noin 6 miljoonaa. Verkkokalvon keskellä on kuitenkin yksi pieni kohta, jossa 
tappisoluja on huomattavasti enemmän kuin sauvasoluja. Tätä kohtaa kutsutaan fo-
veaksi. Fovean keskellä, foveolassa, ei ole lainkaan sauvasoluja. Fovea on tarkan näön 
alue ja siellä tapahtuvat myös ensisijaiset väriaistimukset. (Fraser ym. 2004, 17.)

2.3.1 Trikromaattisuus

Kaikki sauvasolut ovat pohjimmiltaan samanlaisia, mutta tappisoluja on kolmea eri 
tyyppiä. Ne reagoivat ensisijaisesti joko pitkiin, keskikokoisiin tai lyhyisiin aallonpituuk-
siin. Trikromaattisuus tarkoittaa, että ihmisellä on kolmenlaisia reseptoreita, eli tappi-
soluja, värin aistimiseen. ”Trikromaattisuuden tärkeys graafisilla aloilla on siinä, että 
me voimme simuloida lähes mitä tahansa väriä ainoastaan kolmen hyvin valitun valon 
päävärin avulla” (Fraser ym. 2004, 19). (Fraser ym. 2004, 18-19.)

2.3.2 Trikromaattisuusteorian historia

1800-luvulla englantilainen lääkäri Thomas Young oivalsi, että silmässä on kolmenlaisia 
värireseptoreita. Ensin hän määritti, että nämä reseptorit ovat herkistyneet punaiselle, 
siniselle ja keltaiselle värille, mutta myöhemmin täsmensi väreiksi punaisen, vihreän ja 
violetin. Vuonna 1858 Saksalainen neurologi, fyysikko ja fysiologi Herman von Helm-
holtz kehitti Youngin teoriaa, ja nykyään teoria tunnetaankin Youngin-Hermholtzin 
trikromaattisuusteoriana. (Arnkil 2007, 73.)

Saksalaisen havaintopsykologi Ewald Heringin 1800-luvun lopulla kehittämän oppo-
nenttiväri-teorian mukaan näköaistimme käsittelee valoärsykkeitä reagoimalla joko 
värin sisältämään sinisyyteen tai keltaisuuteen ja toisaalta punaisuuteen tai vihreyteen. 
Vastakohtaa tai vastustajaa tarkoittava opponentti-termi tulee siitä, että voimme nähdä 
sinivihreitä tai kellertävän punaisia, mutta emme punavihreitä tai kellertävän sinisiä 
sävyjä. Myöhemmät tutkimukset ovat tukeneet tätä opponenttiteoriaa, mutta edellä 
mainittujen värien rinnalle on lisättävä vielä valkoisuus ja mustuus, jotka myös ovat 
eräässä mielessä aivojen kannalta perusvärejä. (Arnkil 2007, 73.)

Väritapahtuman 
tärkein tekijä on 
silmä.
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3 päävärit JA VÄRIEN MUODOSTUMINEN

Pääväri määritellään yleensä sellaiseksi väriksi, jota ei saada sekoittamalla muita väre-
jä. Päävärin määritelmään kuuluu myös se, että sekoittamalla sitä muiden päävärien 
kanssa, saadaan aikaan muita värejä. (Arnkil 2007, 72.)

Värit voivat sekoittua additiivisesti (lisäävästi), subtraktiivisesti (vähentävästi) tai opti-
sesti (kuva 6). Kunkin sekoitustavan päävärit ovat erilaiset. (Arnkil 2007, 74.)

3.1 Additiivinen värien muodostus

Additiivisella eli lisäävällä väriensekoitustavalla värit muodostuvat sekoittamalla erivä-
risiä valoja eri suhteissa. Additiiviset päävärit ovat punainen (red), vihreä (green) ja 
sininen (blue). Kun kutakin väriä eli valoa lisätään yhtä suuret määrät, syntyy harmaan 
sävy. Valkoinen väri syntyy, kun jokaista väriä lisätään maksimaalinen määrä. Musta 
puolestaan syntyy täysin valottomasta sekoituksesta, eli kun kaikki valot ovat pois pääl-
tä. (Viluksela, Ristimäki & Spännnäri 2007, 25.) Muun muassa tietokoneen näytön värit 
muodostuvat additiivisesti.

Kuva 6. Keltaisen ja syaanin optinen sekoitus, värit muodostavat vihreän

Kuva 7. Additiiviset päävärit
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3.2 Subtraktiivinen värien muodostus

Subtraktiivinen eli vähentävä värinmuodostus perustuu kohteesta heijastuvaan väriin 
(vrt 2.2). Useimpien mielessä värit sekoittuvat subtraktiivisesti; kaikkia värejä sekoitta-
malla saadaan mustaa, kun taas additiivisella sekoitustavalla kaikista väreistä saadaan 
valkoista. Subtraktiiviset päävärit ovat syaani (cyan), magenta (magenta) ja keltainen 
(yellow).

Painettaessa värit muodostetaan subtraktiivisesti. Painoväri absorboi osan tulevasta va-
losta ja heijastaa jäljelle jääneen valon muodostaen värin. Jokainen kolmesta pääväris-
tä imee itseensä tietyn väristä valoa. Esimerkiksi syaani väri imee itseensä punaista, ja 
heijastaa takaisin vihreää ja sinistä valoa. Vihreä ja sininen valo yhdessä muodostavat 
syaanin värin (Kuva 9). (Viluksela ym. 2007, 25.) 

Kuva 9. Valon heijastuminen syaanista väristä (Viluksela ym. 2007, 25)

Kuva 8. Subtraktiiviset päävärit

Kun värejä muodostetaan painamalla, syaanin, keltaisen ja magentan lisäksi käyte-
tään mustaa (key) väriä, sillä täysin mustan aikaansaaminen edellä mainituilla kolmella 
päävärillä ei käytännössä ole mahdollista (Peltonen ym. 2004, 270), sillä värit eivät ole 
täysin puhtaita. 
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3.3 Saman ilmiön eri puolet

Sekä additiivisten että subtraktiivisten päävärien perusta on trikromaattisuudessa. 
Nämä päävärit toimivat muokkaamalla silmään tulevia aallonpituuksia. Muokkaus 
ärsyttää kolmea tappireseptoria, jolloin näemme tietynväristä valoa. (Fraser ym. 2004, 
19-20.)

Vaikka additiivinen ja subtraktiivinen värien sekoittuminen saattavat tuntua kahdelta 
toisistaan riippumattomalta asialta, näin ei kuitenkaan ole. Kuten kuvasta 10 voidaan 
huomata, additiivisten päävärien muodostamat sekundääri- eli välivärit ovat subtraktii-
visen järjestelmän päävärit, ja päinvastoin. Kuvat ovat toistensa positiivi ja negatiivi.

3.4 Numeerinen väri

Paino- ja kuvankäsittelyprosesseissa värit määritellään RGB- tai CMYK-arvoina. Esimer-
kiksi valokuva käsitellään tietokoneella RGB-muodossa, ja ennen kuin se lähetetään 
painoon, se on muutettava CMYK-muotoon.

Digitaaliset RGB- ja CMYK-tiedostot ovat todellisuudessa joukko numeroita, ykkösiä ja 
nollia. Nämä ykköset ja nollat eivät kuvaa väriä, vaan väriaineiden määriä. Voidakseen 
tulkita numerot väriksi tietokone tarvitsee matemaattisia malleja. (Fraser ym. 2004, 
51-53) 

Fraser, Murphy ja Bunting kuvaavat näiden värien matemaattisten mallien epäselvyyttä 
seuraavasti: 

RGB- tai CMYK-tiedoston voi ajatella sisältävän värien sijasta värejä varten re-
septin, jonka kukin laite tulkitsee omien kykyjensä mukaan. Jos annat 20 kokille 
saman reseptin, saat tulokseksi jokseenkin varmasti 20 hieman erilaista ateriaa. 
Samaan tapaan, jos lähetät saman RGB-tiedoston 20 eri monitorille, tai saman 
CMYK-tiedoston 20 eri painoon, saat 20 hieman (tai joissakin tapauksissa enem-
män kuin hieman) erilaista kuvaa. (Fraser ym. 2004, 52.)

Kuva 10. Additiiviset ja subtraktiiviset päävärit
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Jotta esimerkiksi sama CMYK-tiedosto tuottaisi samanlaisen lopputuloksen 20 eri pai-
nosta, mukaan astuu värinhallinta, johon perehdytään luvussa 5. Seuraavissa luvuissa 
käydään hieman tarkemmin läpi RGB- ja CMYK-värejä.

3.4.1 RGB

RGB-värit muodostuvat siis additiivisesti. Lyhenne RGB tulee sanoista red, green ja 
blue, kuten luvusta 3.1 voi päätellä. Selitys sille, miksi värit ilmoitetaan juuri tässä 
järjestyksessä, eikä esimerkiksi BGR, löytyy spektristä. Värit on tapana ilmoittaa aallon-
pituudeltaan pisimmästä lyhyimpään (Fraser ym. 2004, 21).

Kunkin RGB-osavärin arvo voi olla välillä 0-255. Mitä suurempi luku on, sen kirkkaampi 
on valo. Vastaavasti mitä pienempi luku, sen himmeämpi valo. Esimerkiksi arvo R220, 
G140, B60 tuottaa oranssin värin (Kuva 11).

Kuva 11. RGB-arvojen tuottama oranssi

RGB-kuva sisältää kolme kanavaa; punaisen, vihreän ja sinisen (Kuva 12). 8-bittisessä 
kuvassa kullakin kanavalla yhdellä pikselillä on 28 = 256 sävymahdollisuutta. Näin ollen 
siis 8-bittisen RGB-kuvan yhdellä pikselillä on 28 x 28 x 28 = 256 x 256 x 256 = 16,8 
miljoonaa sävymahdollisuutta. (Johansson ym. 2008, 108.) 8-bittinen koodaustapa 
perustuu ihmisen näkökykyyn (Fraser ym. 2004, 62) ja on näin ollen riittävä bittisyvyys 
esimerkiksi valokuville.

Kuva 12. Kuvan 11 oranssi muodostuu kolmen päällekkäisen värikanavan sävyistä

Jos kyseessä on 16-bittinen värikuva, on 3-kanavaisen kuvan yhdellä pikselillä mahdol-
lisuus 216 x 216 x 216 = 65 536 x 65 536 x 65 536 = 2,8 x 1014 = 280 biljoonaan sävyyn 
(Johansson ym. 2008, 108). 16-bittinen kuva on tarpeellinen silloin, jos kuvan värejä 
joudutaan säätämään runsaasti jälkikäteen. 8-bittisen kuvan kohdalla runsas värien 
säätö voi aiheuttaa portaittaista värisävyjen vaihtelua eli posterisaatiota (Kuva 13).
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Kuva 14. Painettu CMYK-väri koostuu eri kokoisista rasteripisteistä (Johansson ym. 2008, 71)

3.4.2 CMYK

CMYK-värit painettaessa muodostuvat subtraktiivisesti. Lyhenne CMYK tulee sanois-
ta cyan, magenta, yellow ja key. Värien järjestys juontuu RGB-värien järjestyksestä. 
CMYK-väreja kutsutaan myös prosessiväreiksi.

RGB-väreistä poiketen CMYK-värien arvot ilmoitetaan prosentteina. Kunkin osavärin 
arvo on siis välillä 0-100%. Prosenttiluvut eivät kuitenkaan tarkoita, että painossa 
jokainen väri sekoitettaisiin osavärien suhteiden mukaan ennen painokoneeseen laitta-
mista. Prosenttiluvuilla ilmaistaan, kuinka suuria kyseisen osavärin rasteripisteet ovat 
(Kuva 14).

Painetun 4-värikuvan värit muodostuvat sekä subtraktiivisesti että optisesti. Kunkin osa-
värin jokaisen rasteripisteen väri muodostuu subtraktiivisesti. Osavärien rasteripisteiden 
kokoja muuttamalla ja painamalla kaikki osavärit päällekkäin saadaan muodostettua 
esimerkiksi kuvan 14 kaltainen punainen sävy optisesti.

Valkoisen värin CMYK-arvo on C0, M0, Y0, K0. Kaikkia osavärejä on siis 0% eli ei 
lainkaan. Käytännössä tämä tarkoittaa, että kohta, joka on täysin valkoinen, jätetään 

Kuva 13. Posterisaatiolla tarkoitetaan portaittaista sävyjen vaihtelua
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ilman painoväriä. Valkoiseksi väriksi määräytyy tällöin paperin väri. Tämän vuoksi on jo 
painotyön suunnitteluvaiheessa tärkeää ottaa huomioon paperin sävy. Vaikka ihmissil-
mä pystyy mukauttamaan muut värit valkoisen värin mukaan (Fraser ym. 2004, 65), on 
kellertävä paperi aina kellertävä.

3.5 Muita värimalleja ja -järjestelmiä

RGB- ja CMYK-värimallien lisäksi kuvankäsittely- ja painoprosesseissa voi törmätä aina-
kin Lab-, HEX- ja Pantonen PMS-väreihin. Lab-väreihin perehdytään luvussa 4.

3.5.1 HEX

HEX- eli heksadesimaaliset väriarvot ovat HTML-kielen koodeja väreille, jotka koostuvat 
kolmesta merkkiparista. Merkkipareissa käytettävät numerot ja kirjaimet ovat 0, 1, 2, 
3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F. Ensimmäinen pari ilmoittaa punaisen, toinen vihreän 
ja kolmas sinisen valon määrän sekoituksessa. Arvo 00 ilmaisee valon minimaalisen ja 
arvo FF maksimaalisen määrän. (Arnkil 2007, 171.) Esimerkiksi punainen, jonka RGB-
arvot ovat R200, G0, B20, ilmaistaisiin HEX-arvoina C80014.

3.5.2 Pantone

Pantone, Inc. on vuonna 1963 perustettu värialan yritys, joka valmistaa värikarttoja 
muun muassa graafisen alan käyttöön. Graafisen alan kartoista tunnetuin on PANTONE 
MATCHING SYSTEM - eli PMS-väreistä koostuva PANTONE FORMULA GUIDE. Se sisäl-
tää 1 114 Pantone väriä päällystetylle, päällystämättömälle ja mattapintaiselle paperil-
le, sekä painovärireseptin kullekin värille. Muita Pantonen värikarttoja ovat PANTONE 
COLOR BRIDGE®, jonka avulla voi löytää PMS-värille RGB- tai CMYK-väreistä lähimmän 
vastineen, PANTONE HEXACHROME®, jonka väreissä on käytetty neljän sijasta kuutta 
prosessiväriä, sekä PANTONE 4-COLOR PROCESS GUIDE, jossa on yli 3000 CMYK-väriä. 
Uusin värikartta on syyskuussa 2007 julkistettu PANTONE Goe™, jossa on 2058 uutta 
väriä painoväriresepteineen ja sRGB-arvoineen. (Pantone.)
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4 CIE

CIE on insinööreistä ja tutkijoista koostuva yhteisö, joka on tutkinut valoa jo lähes sa-
dan vuoden ajan. Se on tuottanut sisä- ja ulkovalaistukseen liittyviä standardeja teolli-
suuden ja suunnittelijoiden käyttöön. Lyhenne CIE tulee sanoista Comission Internatio-
nal de l’Éclairage (Kansainvälinen valaistuskomissio). (Arnkil 2007, 165.)

4.1 CIE XYZ

Kansainvälinen valaistuskomissio otti tavoitteekseen 1920-luvulla luoda järjestelmän, 
”joka mahdollistaisi kaikkien ihmisen havaitsemien värien yksiselitteisen ja tarkan 
määrittämisen” (Arnkil 2007, 165). Vuonna 1931 CIE sai valmiiksi tämän työn, joka on 
nimeltään CIE XYZ-järjestelmä. Nykyisin värimittareiden ja näytön värikalibrointi pe-
rustuu CIE:n mukaisiin mitta-arvoihin ja -normeihin. (Arnkil 2007, 165.) Kuvassa 15 on 
esitetty CIE 1931 xy -diagrammi.

Kuva 15. CIE 1931 xy -diagrammi (Arnkil 2007, 166)

4.2 CIELAB

CIE julkaisi vuonna 1976 kaksi uutta versiota värijärjestelmästään; CIE L*a*b* sekä 
CIE L*u*v* (viralliset lyhenteet vuodesta 1978 CIELAB ja CIELUV). Erityisesti  
CIELABista on tullut yleisesti sovellettu värimalli ja LABilla viitataankin vastaavaan 
muotoon perustuviin värimalleihin, vaikka ne eivät perustuisikaan CIEn määrittelemiin 
pääväreihin. (Arnkil 2007, 168) 
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CIE-värimalleista CIELAB on todennäköisin, jonka kanssa joutuu joskus tekemisiin 
graafisella alalla. Esimerkiksi Photoshopissa on mahdollista muokata ja tallentaa kuvia 
LAB-muodossa.

CIELAB perustuu tapaamme arvioida väriä. L* tarkoittaa vaaleutta, a* värin punai-
suutta tai vihreyttä ja b* värin sinisyyttä tai keltaisuutta. LAB-malli pyrkii mallintamaan 
numeerisesti ihmisen värinäköä (vrt. 2.3). Siinä missä RGB- ja CMYK-värit ovat laite-
riippuvaisia, LAB on laiteriippumaton numeerinen värimalli. (Fraser ym. 2004, 69-70.) 
CIELAB-väriavaruutta on havainnollistettu kuvassa 16.

Kuva 16. CIELAB-väriavaruus on täysin symmetrinen (Arnkil 2007, 168)



17

5 Värinhallinta

Jotta vältettäisiin kohdassa 3.4 kuvattu tilanne, jossa esimerkiksi sama CMYK-tiedosto 
tuottaisi enemmän tai vähemmän erilaisia lopputuloksia, tarvitaan värinhallintaa. Tä-
män luvun tarkoituksena on selvittää, mitä värinhallinnalla tarkoitetaan ja mistä osista 
se koostuu.

5.1 Värinhallinan synty

Vielä 80-luvulla ei tarvittu värinhallintaa. Valokuvat otettiin filmikameralla ja negatiivista 
kehitettiin kino- tai diakuva. Kuva toimitettiin painoon, jossa se kuvattiin ja värieroteltiin 
reprokameralla tai rumpuskannerilla. Värierottelun jälkeen kuva siirrettiin painolevyille 
ja painettiin. Oli siis vain yksi väylä, jota pitkin kuva saatiin julkaisun sivulle. (Salonen 
2008.)

Vaikka siirtyminen digiaikaan on helpottanut monia asioita, on se tuonut mukanaan 
myös ongelmia. Yksi ongelma on kuvien värinhallinta. Niin syöttö- kuin tulostuspäässä 
on nykyään paljon erilaisia vaihtoehtoja; tasoskannereista digikameroihin, ja digitaali-
sista vedostuslaitteista lasertulostimiin. Tämä vaihtoehtojen runsaus hajottaa aiemman 
yhtä lukujoukkoa käsitelleen suljetun silmukan ja tuloksena on valtava määrä mahdol-
lisia muunnoksia syöttölaitteesta tulostuslaitteelle. Erilaisia syöttö-tulostus-muunnoksia 
tarvitaan syöttölaitteiden määrä x tulostuslaitteiden määrä. Värinhallinta tarjoaa tähän 
ratkaisuksi profiilien yhdysavaruuden. Syöttö-tulostusmuunnoksia sekä yhdysavaruuden 
tarjoamaa helpotusta on havainnollistettu kuvassa 17. (Fraser ym. 2004, 81.) 

Kuva 17. Erilaisten syöttö-tulostus-muunnosten määrä ilman yhdysavaruutta ja yhdysavaruuden 

avulla (Fraser ym. 2004, 81-82)
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5.2 Värinhallinnan osatekijät

Kaikki ICC-pohjaiset värinhallintajärjestelmät koostuvat neljästä perusosasta; yhdysa-
varuudesta, profiileista, värinhallintamoduulista sekä muunnosalgoritmeistä (Fraser ym. 
2004, 83).

5.2.1 PCS

PCS:n (profile connection space) eli profiilien yhdysavaruuden avulla värille voidaan 
antaa yksiselitteinen numeerinen arvo CIE XYZ- tai CIELAB-väriavaruudessa (Fraser 
ym. 2004, 84). Kuten luvussa 4 todettiin, nämä väriavaruudet kuvaavat ihmisen havait-
semaa väriä. 

Yhdysavaruutta voi ajatella välipysäkkinä, jolla kaikki värimuunnokset käyvät pysähty-
mässä ja hakemassa CIE XYZ- tai CIELAB-arvot, joilla ne voivat kertoa värinhallintajär-
jestelmän seuraavalle kohteelle miten normaalilla värinäöllä varustettu ihminen kyseiset 
värit näkee.

5.2.2 Profiilit

Profiili määrittää yksittäisen laitteen, kuten monitorin tai painokoneen väriavaruuden. 
Profiili sisältää sekä ohjaussignaaliarvoja, eli RGB- tai CMYK-arvoja, sekä niitä vastaa-
vat, yhdysavaruudessa kuvatut CIE XYZ- tai CIELAB-arvot. Profiili ei muuta RGB- tai 
CMYK-arvoja, vaan antaa niille merkityksen XYZ- tai LAB-avaruuden avulla. (Fraser ym. 
2004, 84.)

Profiilin voi ajatella olevan tulkki, joka kulkee valokuvan mukana, ja tulkkaa värinhallin-
tajärjestelmälle, mitä värejä valokuva sisältää.

5.2.2.1 Lähde- ja kohdeprofiili

Värien muuntamisessa tarvitaan aina sekä lähde- että kohdeprofiili. Lähdeprofiili kertoo 
värinhallintajärjestelmälle, mistä värit tulevat, ja kohdeprofiili minne ne ovat menossa. 
(Fraser ym. 2004, 85, 94.)

Kuvitellaan tilanne, jossa digikameralla otetaan kuva aiemminkin esimerkkinä käytetys-
tä punaisesta omenasta ja kuva lähetetään painoon jotakin julkaisua varten. Kameran 
otettua kuvan tuloksena on RGB-kuva. Kamera tarvitsee profiilin, jotta värinhallintajär-
jestelmälle voitaisiin kertoa, kuinka tämä tietty kamera näkee värit; mikä on omenan 
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juuri oikea punainen väri. Tämä profiili on lähdeprofiili. Tämän jälkeen kuva täytyy 
muuntaa CMYK-muotoon, jotta se voidaan lähettää painoon. Kun tiedossa on, mihin 
painoon kuva ollaan lähettämässä ja millaiselle paperille kuva tullaan painamaan, tarvi-
taan juuri sen kyseisen painokoneen tähän tilanteeseen tarkoitettu CMYK-profiili. Tämä 
profiili kertoo värinhallintajärjestelmälle, miten tuo painokone toistaa värejä. Tämä on 
kohdeprofiili. Lähdeprofiili siis kertoo värinhallintajärjestelmän avulla kohdeprofiilille, 
mikä on omenan oikea punainen väri. Tähän esimerkkitilanteeseen viitataan myöhem-
missä kappaleissa omena-esimerkkinä.

5.2.2.2 Syöttö-, näyttö- ja tulostusprofiili

Profiilit voidaan jakaa kolmeen luokkaan. Syöttöprofiileihin kuuluvat skannereita ja 
digikameroita kuvailevat, näyttöprofiileihin monitoreja ja LCD-näyttöjä kuvailevat ja 
tulostusprofiileihin tulostimia ja painokoneita kuvailevat profiilit. Syöttö- ja lähdeprofii-
lia, sekä kohde- ja tulostusprofiilia ei pidä sekoittaa 
toisiinsa. Syöttö- ja tulostusprofiileilla tarkoitetaan 
erillisiä laitetyyppejä, joita nuo profiilit kuvailevat. 
Lähde- ja kohdeprofiileilla puolestaan tarkoitetaan 
kahden profiilin väliaikaisia rooleja värinhallintajärjestelmän muuntaessa niiden avulla 
värejä laitteelta toiselle. (Fraser ym. 2004, 100,108.)

Yksi näitä kolmea profiililuokkaa erottava tekijä on se, ovatko ne yhden- vai kahden-
suuntaisia. Tällä tarkoitetaan sitä, sallivatko profiilit värinhallintajärjestelmän tehdä vä-
rimuunnoksia  laitteen väriavaruudesta profiilien yhdysavaruuteen ja toisin päin. Toisin 
sanoen sopivatko ne lähde- ja kohdeprofiileiksi. (Fraser ym. 2004, 100.)

Syöttöprofiilien tarvitsee määritellä ainoastaan muunnos syöttölaitteen väriavaruudesta 
yhdysavaruuteen (Fraser ym. 2004, 100). Omena-esimerkissä kamera toimii syöttölait-
teena ja tarvitsee syöttöprofiilin. Ei kuitenkaan ole tarpeellista muuntaa värejä yhdys-
avaruudesta kameran väriavaruuteen. Näin ollen syöttöprofiilit ovat yhdensuuntaisia ja 
toimivat lähdeprofiileina. 

Näyttöprofiilien on oltava kahdensuuntaisia, sillä näyttölaitteet voivat toimia sekä 
syöttö- että tulostuslaitteena. Omena-esimerkissä, kun valokuva siirretään kamerasta 
tietokoneelle, ja näytetään näytöllä, näyttö toimii tulostuslaitteena; kameran profiili on 
syöttöprofiili ja näytön profiili tulostusprofiili. Kun valokuvan värejä säädetään näytöllä 
näkyvän ilmiasun perusteella, näyttö toimii syöttölaitteena. (Fraser ym. 2004, 101.)

Tulostusprofiilit ovat myös kahdensuuntaisia (Fraser ym. 2004, 102). Kun valokuvan 
värit on säädetty omena-esimerkissä halutuiksi, kuva muunnetaan CMYK-muotoon ja 
siihen sisällytetään painon CMYK-profiili. Muunnoksen jälkeen tämä CMYK-profiili toimii 

Profiili voi olla yhden- 
tai kahdensuuntainen.
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sekä tulostus-, että syöttöprofiilina. Painokoneelle se toimii tulostusprofiilina, ja näytölle 
syöttöprofiilina.

5.2.2.3 ICC

1980- ja -90 -luvun taitteessa useat yhtiöt kehittivät värinhallintajärjestelmiä, joiden 
avulla pyrittiin ratkaisemaan laitteiden välisiä väriensovitusongelmia profiilien avulla. 
Tämä ei kuitenkaan tuonut täydellistä ratkaisua ongelmiin, sillä eri yhtiöiden kehittämät 
profiilit eivät olleet yhteensopivia keskenään. Vuonna 1993 Apple Computer, Inc. esitteli 
ColorSyncin; sisäänrakennettu värinhallinta-arkkitehtuuri Macintosh-käyttöjärjestelmäs-
sä. (Fraser ym. 2004, 85.) Samana vuonna kahdeksan yhtiötä, mukaan lukien Apple 
Computer, Inc., perusti yhteenliittymän, joka tunnetaan nimellä International Color 
Consortium (ICC). ICC:n profiilien määrittely perustuu Applen ColorSyncin profiilifor-
maattiin ja heidän tavoitteenaan on ”luoda, markkinoida ja kannustaa avoimen, valmis-
taja- ja alustariippumattoman värinhallintajärjestelmän arkkitehtuurin ja komponenttien 
kehitystä”. (International Color Consortium.)

5.2.3 Värinhallintamoduuli

Värinhallintamoduuli eli CMM-laskin on ohjelma, joka tarjoaa menetelmän, jolla vä-
rinhallintajärjestelmä muuntaa lähdeväriavaruuden arvoja yhdysavaruuden arvoiksi ja 
yhdysavaruuden arvoja kohdeväriavaruuden arvoiksi. CMM-laskin muuntaa RGB- tai 
CMYK-arvot profiilien avulla. Yhdistelmiä, joista lyhenteen CMM sanotaan juontuvan 
ovat esimerkiksi Color Management Module ja Color Matching Method. (Fraser ym. 
2004, 86.) 

Profiili ei voi sisältää PCS-määritelmää kaikkia mahdollisia RGB- tai CMYK-lukuyhdis-
telmiä varten, sillä silloin yksittäinen väriprofiili olisi kohtuuttoman suuri. Sen vuoksi 
tarvitaankin CMM-laskinta kuvailemaan tapaa, jolla profiilissa jäljellä olevien pisteiden 
avulla lasketaan väliin jäävien pisteiden arvot; tätä kutsutaan interpoloinniksi. (Fraser 
ym. 2004, 86-87.)

5.2.4 Muunnosalgoritmit

Kullakin laitteella on kiinteä värialue, jonka se pystyy toistamaan; tulostin ei voi tuottaa 
kylläisempää syaania kuin sen syaani muste. Tätä väriskaalaa, jonka laite pystyy toista-
maan, kutsutaan toistoalaksi. (Fraser ym. 2004, 88.)
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Kuvassa 18 on esitetty Adobe RGB (1998) RGB-profiilin sekä ISO coated v2 300% (ECI) 
CMYK-profiilin väriavaruudet Lab-kuvaajassa. Kuten kuvasta voi huomata esimerkkinä 
olevan RGB-avaruuden toistoala on huomattavasti laajempi kuin CMYK-avaruuden. 

Kuva 18. Adobe RGB (1998) sekä ISO coated v2 (ECI) profiilien väriavaruudet Lab-kuvaajassa 

ColorSync-työkalun kuvaamana

Adobe RGB (1998)

ISO Coated v2 300% (ECI)

”Niitä lähdeavaruuden värejä, joita ei voi toistaa kohdeavaruudessa, kutsutaan toisto-
alan ylittäviksi väreiksi (out-of-gamut colors). Koska noita värejä ei voida toistaa koh-
deavaruudessa, ne täytyy korvata joillain muilla väreillä. Nuo muut värit määritellään 
muunnosalgoritmien avulla.” (Fraser ym. 2004, 88.) Seuraavassa käydään läpi neljä 
erilaista menetelmää toistoalan ulkopuolisten värien käsittelyyn, eli muunnosalgoritmia, 
jotka ICC-profiilistandardi sisältää:

• Havainnollinen muunnosalgoritmi (perceptual) pyrkii säilyttämään kuvan 
kokonaisvärivaikutelman. Se muuttaa kaikkia lähdeavaruuden värejä koh-
deavaruuden sisään mahtuviksi siten, että se säilyttää värien väliset suh-
teet. Silmä on herkempi värien välisille suhteille, kuin niiden absoluuttisille 
väriarvoille. Havainnollista muunnosalgoritmia on hyvä käyttää silloin, kun 
alkuperäinen kuva sisältää paljon toistoalan ylittäviä värejä. (Fraser ym. 
2004, 89.)

• Kylläisyyden säilyttävä algoritmi (saturation) ei keskity värien täsmälli-
syyteen. Se pyrkii muuntamaan lähdeavaruuden kylläiset värit kohdeava-
ruuden kylläisiksi väreiksi. Tämä muunnosalgoritmi on hyvä vaihtoehto 
esimerkiksi kaavioihin, joissa värin kylläisyyseroilla kuvataan jotakin 
muuttujaa, mutta täsmällistä värintoistoa vaativiin kuviin se ei ole käyttö-
kelpoinen. (Fraser ym. 2004, 89.)
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• Suhteellinen kolorimetrinen algoritmi (relative colorimetric) ottaa huomi-
oon sen, että silmä käyttää valkoista väriä kaikkien muiden värien kiinto-
pisteenä (Fraser ym. 2004, 65). Tämä muunnosalgoritmi kuvaa lähdeava-
ruuden valkoisen kohdeavaruuden valkoiseksi. Tulosteen valkoinen on siis 
paperin valkoinen, ei lähdeavaruuden valkoinen. Muut toistoalan sisällä 
olevat värit toistetaan täsmällisesti, ja toistoalan ylittäville väreille etsitään 
lähin toistettava sävy. Havainnolliseen muunnosalgoritmiin verrattuna suh-
teellinen kolorimetrinen algoritmi säilyttää enemmän alkuperäisiä värejä. 
(Fraser ym. 2004, 89.)

• Absoluuttinen kolorimetrinen muunnosalgoritmi (absolute colorimetric) 
ei kuvaa lähdeavaruuden valkoista kohdeavaruuden valkoiseksi, kuten 
suhteellinen kolorimetrinen, vaan säilyttää valkoisen lähdeavaruuden 
valkoisena. Tämä algoritmi on tarkoitettu pääasiassa koevedoksiin simu-
loidakseen painotulosta. (Fraser ym. 2004, 89.)

Näiden muunnosalgoritmien vaikutusta valokuvan väreihin havainnollistetaan luvussa 9.
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6 Prosessinhallinta

Prosessinhallinnalla tarkoitetaan vaihteluiden tarkkailua ja kompensointia. Värinhallin-
nassa se tarkoittaa laitteiden kalibrointia, profilointia ja valvontaa. (Fraser ym. 2004, 
114.) Prosessinhallinta on erittäin tärkeä osa värinhallitussa tuotannossa. Esimerkiksi 
jos tietokoneen näyttö on kalibroimaton ja profiloimaton, voi muuten tarkasti värinhal-
littu työnkulku tuottaa ei-toivotun lopputuloksen. 

6.1 Kalibrointi ja profilointi

Kalibrointi ja profilointi ovat käsitteitä, jotka hyvin usein sekoitetaan toisiinsa tai niitä 
pidetään samaa tarkoittavina. Tarkoitettaessa profilointia puhutaan kalibroinnista ja 
päinvastoin. 

Kalibroinnissa muutetaan laitteen toimintaa ärsykkeen ja reaktion avulla. Profiloinnissa 
reaktio rekisteröidään ja se tallennetaan profiiliin. 
Kalibroinnin ja profiloinnin ero on siis siinä, että 
kalibroinnissa todella muutetaan jonkin laitteen 
käyttäytymistä säätämällä jotakin, ja profiloinnissa 
vain kuvataan laitteen käyttäytymistä profilointihetkellä. (Fraser ym. 2004, 114-115). 
Sekaannukset näiden kahden käsitteen välillä johtunevat siitä, että näytön kalibrointi/
profilointipaketit suorittavat sekä kalibroinnin että profiloinnin yhtenä operaationa.

6.2 Näytön kalibrointi/profilointi

Seuraavassa on esitetty näytön kalibrointi/profilointi vaihe vaiheelta. Toimenpide suori-
tettiin Datacolorin Spyder3 Elite kalibrointilaitteella Apple iMacille (20-inch Late 2006).

Ennen kalibroinnin/profiloinnin aloittamista tulee mahdolliset näytön- ja virransäästäjät 
kytkeä pois käytöstä.

Kalibroinnilla muutetaan, 
profiloinnilla kuvaillaan.
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I. Mikäli näyttöä ollaan 

kalibroimassa ensimmäis-

tä kertaa ja sovellus on 

vasta asennettu koneel-

le, ensimmäinen ikkuna 

sovelluksen avaamisen 

jälkeen näyttää tältä. Mer-

kitsemällä kohta ”Calibra-

te this display” päästään 

aloittamaan.

II. Seuraavaksi sovellus 

pyytää määrittelemään, 

mitä laitetta ollaan kalib-

roimassa. Tässä tapauk-

sessa kohteena oli Apple 

iMac, joten valintana on 

LCD. 

III. Seuraavassa ikkunas-

sa tulee määritellä mitä 

säätömahdollisuuksia 

näytössä on. Esimerkiksi 

iMacissä voidaan säätää 

vain yhtä ominaisuutta, 

joka on ”Backlight”.

Näyttöä ei ole kalibroitu aiemmin
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IV. Kun säätömahdol-

lisuudeksi on valittu 

”Backlight”, seuraavassa 

ikkunassa näkyvästä ku-

vasta tulisi erottaa neljä 

laatikkoa. Mikäli näin ei 

ole, tulee näyttöä säätää 

niin, että ne erottuvat.

V. Seuraavassa ikkunassa 

sovellus pyytää määrit-

telemään, onko näytön 

värilämpötilaa mahdollista 

säätää, ja jos on, niin 

miten. iMacissä ei Kelvin-

asteiden säätömahdol-

lisuutta ole, joten tämä 

kohta jätetään tyhjäksi ja 

siirrytään eteenpäin.

VI. Kalibrointilaite voi-

daan asettaa näytölle 

joko imukupin avulla tai 

ilman. Tässä ikkunassa 

sovellus kysyy kumpaa 

vaihtoehtoa tullaan käyt-

tämään. LCD-näytöissä 

imukupin käyttö ei ole 

suositeltavaa, sillä se 

voi vahingoittaa näytön 

pintaa. (Jatkuu kohdassa 

XII.)
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VII. Mikäli näyttö on 

kalibroitu/profiloitu jo 

aiemmin, ensimmäinen 

ikkuna sovelluksen käyn-

nistämisen jälkeen on 

yhteenvetoikkuna. Mikäli 

aiemmin määriteltyjä ase-

tuksia halutaan muuttaa, 

valitaan ”Change these 

settings”.

VIII. Kuten sovelluskin 

ilmoittaa ohjeessaan, ylei-

sin gamma-arvo on 2.2 ja 

värilämpötila 6500 K.

IX. Sovellusta voi pyytää 

tarkkailemaan näytön 

toimintaa ja ilmoittamaan, 

mikäli näyttö ei toimi 

tehdyn kalibroinnin/profi-

loinnin mukaisesti.

Näyttö on kalibroitu aiemmin
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X. Harmaatasapainon 

käyttö kalibroinnissa voi-

daan kytkeä pois päältä. 

Yleisesti se kuitenkin 

kannattaa pitää päällä. 

XI. Spyder3Elite-kalib-

rointilaite pystyy mittaa-

maan tilan vallitsevaa 

valoa ja suhteuttamaan 

sen kalibrointiin. Tämä 

toiminto on kuitenkin 

syytä pitää pois päältä. 

Toiminnon käyttäminen 

on käyttökelpoinen aino-

astaan silloin, kun tila, 

jossa näyttö sijaitsee, on 

valaistukseltaan tarkasti 

kontrolloitu.

XII. Ennen kalibroinnin 

aloittamista sovellus näyt-

tää yhteenvedon näytön 

asetuksista. Mikäli asetuk-

sissa ei ole muutettavaa, 

merkitään kohta ”Conti-

nue with these settings” 

valituksi.
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XIII. Kun asetukset on 

saatu valmiiksi, näytölle 

ilmestyy kuva kalibrointi-

laitteesta. Tämän kuvan 

avulla laite asetetaan 

oikeaan kohtaan.

XIV. Kalibrointilaite 

tulee asettaa roikkumaan 

näytölle kuvan osoitta-

malla tavalla. Kun laite 

on kohdistettu, voidaan 

aloittaa kalibrointi valitse-

malla ”Continue”. Sovel-

lus ryhtyy näyttämään 

näytöllä erivärisiä neliöitä, 

joita laite lukee koko ajan 

ja luo lukemiensa tietojen 

avulla profiilin. Kalibroin-

nin aikana laitetta ei tule 

liikutella.

XV. Kalibroinnin jälkeen 

sovellus pyytää nimeä-

mään luodun profiilin. 

Tämä profiili tallentuu 

tietokoneelle ja on käytet-

tävissä näytön profiilina. 
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XVI. Tämän ikkunan 

avulla voidaan verrata 

näytön värejä ennen ja 

jälkeen kalibroinnin. Ero 

näiden välillä voi olla 

hyvinkin suuri. Esimerkiksi 

iMac-profiili verrattuna 

Spyder3Elitellä luotuun 

profiiliin on huomattava.

XVII. Ennen sovelluksen 

sulkemista se muistuttaa, 

että näytön kaikki ase-

tukset tulisi säilyttää sen 

hetkisissä arvoissa. Jos 

mitä tahansa asetusta 

muutetaan, tulee näyt-

tö kalibroida/profiloida 

uudelleen.
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7 VALOKUVAUS

Valokuvan värinhallinnan ensimmäinen ja tärkeä tekijä on kuvaustilanne. Erityisesti 
JPG-kuvien kohdalla kuvaustilanteen vaikutus lopputulokseen on suuri, raakakuvien 
kohdalla säätömahdollisuudet jälkikäteen ovat paremmat. 

Seuraavissa esimerkeissä käytetyt valokuvat motocross-kypärästä kuvattiin kalibroimat-
tomalla Canon EOS 30D järjestelmäkameralla. Väriprofiilina käytettiin Adobe RGB:tä ja 
valoherkkyys ISO 100. Adobe RGB on sRGB:tä parempi vaihtoehto kuvan profiiliksi, sillä 
sen väriavaruus on suurempi, se toistaa siis enemmän värejä.

7.1 Valaistus

Kuvaustilanteessa käytettyjen valojen värilämpötilan tulisi olla sama. Tilannetta, jossa 
kohdetta valaisee esimerkiksi luonnonvalo ja hehkulamppuvalaistus, tulisi välttää.

Esimerkeissä käytetyt kypärä-kuvat kuvattiin kolmessa eri valaistuksessa. Ensimmäiset 
kuvat otettiin studion vallitsevassa valaistuksessa. Studion loisteputkilamput olivat väri-
lämpötilaltaan noin 6000K. Toisessa valaistustilanteessa käytettiin Cosmobeam 1000 W 
halogeenilamppua, jonka värilämpötilaksi ilmoitettiin 3200 K. Kolmannessa kuvaustilan-
teessa käytettiin Elinchrom D-lite 4 studiosalamaa varjon kanssa. Esimerkkikuvat näistä 
kuvaustilanteista on alla olevassa kuvassa (Kuva 19). Kuvia ei ole säädetty jälkikäteen, 
vaan ne ovat suoraan kamerasta.

Kuva 19. Sama kohde kolmessa eri kuvaustilanteessa; vallitseva loisteputkivalaistus (2 s. f/11) 

(vas.), halogeenivalaistus (0,4 s. f/11) ja studiosalama (1/125 s. f/11) (oik.)
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7.2 Tausta ja valkotasapaino

Mikäli kuva on tarkoitus syvätä ja kohde kuvataan valkoista taustaa vasten, ei tausta 
saa olla ns. vitivalkoinen, kuten esimerkiksi tavallinen kopiopaperi. Vitivalkoinen tausta 
aiheuttaa kuvaan sinisyyttä. Sinertävyyden voi todeta esimerkiksi laittamalla paperiar-
kin talvella hangelle; lumen valkoiseen väriin verrattuna arkki näyttää violetilta. Sinertä-
vyys johtuu siitä, että useiden papereiden valkaisuun on käytetty fluoresoivia kirkastei-
ta (Fraser ym. 2004, 15). Taustana tulisi siis käyttää luonnonvalkoista taustaa.

Kypärä-kuvat kuvattiin kuitenkin valkoisen taustan sijasta keskiharmaata taustaa vas-
ten, sillä valkoista taustaa vasten kuvattaessa kohteen reunat voivat muuttua utuisiksi 
ja kohteen värit haalistuvat reunoilta taustan heijastuksesta (Kuva 20). 

Valokuvan oikea valkotasapaino on kuvan värien kannalta hyvin oleellinen tekijä. Valko-
tasapainon manuaaliseen asettamiseen on olemassa eri valmistajien valkoisia kohteita, 
mutta käyttökelpoinen vaihtoehto on valkoinen paperi, ei kuitenkaan esimerkiksi taval-
linen kopiopaperi aiemmin mainituista syistä. Valkotasapainon asetukset tulee määrit-
tää uudelleen, mikäli kuvausolosuhteet muuttuvat. Jos valkotasapainon asetukset ovat 
väärät, valokuva voi sävyttyä paljonkin (Kuva 21).

Oikean valotusajan löytymiseen apuna toimii kameran histogrammi. Jo kuvaustilantees-
sa tulisi valokuvan musta ja valkoinen piste löytää mahdollisimman tarkasti. 

7.3 Värikohde

Valokuvan oikean valkotasapainon varmistamiseksi myöhemmin voidaan käyttää vä-
rikohdetta. Värikohteita on olemassa useita ja niiden ulkonäkö vaihtelee valmistajan 
mukaan. Värikohde asetetaan kuvattavaan kohtaan niin, että se on kohtisuorassa 
kameraan. Värikohde ei saa olla osittain varjossa, eikä siihen saa tulla heijastuksia tai 

Kuva 20. Taustavärin vaikutus kohteen väreihin
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kiiltoja. Kuvattava kohde kuvataan värikohteen kanssa samoilla asetuksilla ja samassa 
kuvaustilanteessa kuin ilman värikohdetta. Värikohteen 
avulla valokuvan värejä voidaan säätää myöhemmin 
kuvankäsittelyohjelmassa. Tätä käsitellään tarkemmin 
luvussa 8.

Kuvassa 22 on esimerkkikuvia kuvista värikohteen kanssa. Ennen-kuvat ovat suoraan 
kamerasta tuotuja kuvia ja Jälkeen-kuvien valkotasapainoa on säädetty jälkikäteen 
värikohteen avulla. Jos vertailee Ennen- ja Jälkeen-kuvaa, muutokset eivät ole suuria, 
sillä säädöt ja asetukset tehtiin mahdollisimman hyvin jo kuvaustilanteessa. Jos taas 
vertailee jälkeen-kuvia keskenään, värien sävyissä voi huomata eroja. Erot huomaa sel-
vimmin harmaassa taustassa. Eri valmistajien värikohteet antavat siis hieman erilaisia 
arvoja. Kuvat on esitetty myös liitteissä 1–5.

Kuva 21. Halogeenivalaistuksessa otettu kuva vallitsevan loisteputkivalaistuksen valkotasapainon 

asetuksilla (vas.) ja studiosalaman kanssa otettu kuva halogeenivalaistuksen asetuksilla

Oikea valkotasapaino 
on värien kannalta 
tärkeä tekijä.
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Kuva 22. A. Qpcard, B. KODAK, C. art innovation, D. SnapChecker®, E. Munsell ColorChecker®
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8 PHOTOSHOPIN JA INDESIGNIN VÄRIASETUKSET

Värinhallitussa työnkulussa käytettävien sovellusten väriasetukset ovat luonnollisesti 
ensiarvoisen tärkeitä. Seuraavassa on käyty läpi sekä Adobe Photoshop CS3:n että 
Adobe Indesign CS3:n väriasetukset ja mahdolliset varoitukset koskien värinhallintaa. 
Sovellukset käsitellään rinnakkain, sillä niiden käyttöliittymät värinhallinnan osalta ovat 
lähes identtiset.

Sekä Photoshopin että Indesignin väriasetukset (”Color Settings”) löytyvät ”Edit”-va-
likosta (Kuva 23). Valintaikkuna on molemmissa sovelluksissa hyvin samanlainen niin 
ulkonäöltään kuin sisällöltään.

Kuva 23. Sekä Photoshopin että Indesignin (oik.) väriasetukset löytyvät ”Edit”-valikosta

”Color Settings” -ikkunan ”Settings”-valikosta löytyy valmiiksi tallennettuja määrityksiä, 
kuten ”Europe Prepress 2”, sekä itse tallennetut määritykset (Kuva 23).

”Working Spaces” -osiossa voi valita RGB- ja CMYK-oletusprofiilit, jotka määrittävät uu-
sien tiedostojen profiilin (Kuva 23). Kun siis luodaan uusi tiedosto, sen profiiliksi määri-
tellään automaattisesti työtilaprofiili, eli se RGB- tai CMYK-profiili, joka väriasetuksissa 
on valittuna. (Fraser ym. 2004, 324.)

”Color Management Policies” -osiossa (Kuva 23) valitut toiminnot vaikuttavat siihen, 
miten sovellus toimii avattaessa sellaisia tiedostoja, joissa ei ole profiilia tai niihin sisäl-
lytetty profiili ei ole sama kuin työtilaprofiili, tai kun luodaan uusia tiedostoja. Indesig-
nissa nämä asetukset eivät vaikuta tuotuihin objekteihin (Fraser ym. 2004, 324). Jos 
vaihtoehdoista on valittuna ”Off”, ei värinhallinta kuitenkaan ole poissa käytöstä. Kun 
uusi tiedosto luodaan ”Off”-valinnalla, sovellus olettaa profiiliksi valitun työtilaprofiilin. 
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Tiedostoa käsitellään kuitenkin profiilittomana. Profiilittomana käsittely tarkoittaa, että 
jos työtilaa muutetaan, muuttuu myös tiedoston profiili ja näin ollen myös tiedoston il-
miasu. Kun avataan tiedosto, johon on sisällytetty jokin muu kuin työtilaprofiili, sovellus 
hylkää sisällytetyn profiilin ja toimii kuten uuden tiedoston kanssa; olettaa työtilaprofii-
lin ja käsittelee profiilittomana. Jos taas sisällytetty profiili on sama kuin työtilaprofiili, 
sovellus käsittelee tiedostoa profiloituna; myöhemmät työtilan muutokset eivät muuta 
tiedostoa. (Fraser ym. 2004, 325.)

”Preserve Embedded Profiles” -valinnalla sovellus säilyttää sisällytetyn profiilin avatta-
vissa ja käyttää työtilaprofiilia uusissa tiedostoissa. Tällä valinnalla tiedostoja käsitellään 
profiloituina. Alunperin profiilittomat tiedostot säilyvät profiilittomina. (Fraser ym. 2004, 
326.)

Jos valittuna on ”Convert to Working Space”, avattaessa tiedostoa, jossa on sisällytetty-
nä jokin muu kuin työtilaprofiili, sovellus konvertoi eli tekee muunnoksen sisällytetystä 
profiilista työtilaprofiiliin; tiedoston ilmiasu ei muutu. Profiiliton tiedosto säilyy profiilitto-
mana, ja oletettuna profiilina käytetään työtilaprofiilia. (Fraser ym. 2004, 326.)

Indesignissa CMYK-tiedostoille on olemassa neljäskin valintamahdollisuus, ”Preserve 
Numbers (Ignore Linked Profiles)”. Tämä valinta säilyttää sisällytetyn CMYK-profiilin 
tiedostoa avattaessa. Kun tiedostoon tuodaan CMYK-objekteja, niiden profiilit oletus-
arvoisesti jätetään huomiotta. Tämä voidaan kuitenkin ohittaa käsin ”Object”-valikosta 
löytyvän ”Image Colour Settings” -toiminnon avulla. 

”Profile Mismatches” - ja ”Missing Profiles” -valintaruudut (Kuva 23) mahdollistavat työ-
tilan oletustoimintojen ohittamisen käsin. Kun kohdan ”Profile Mismatches” ”Ask when 
opening” -ruutu on valittuna, avattaessa tiedostoa, johon on sisällytetty jokin muu kuin 
työtilaprofiili, ilmestyy kuvan 24 kaltainen varoitusikkuna. Photoshopin varoitus tarjoaa 
kolme vaihtoehtoa sille, miten tiedostoa käsitellään. Nämä kolme vaihtoehtoa vastaa-
vat ”Color Management Policies” -osion toimintoja. Indesignin varoitus tarjoaa kaksi 
vaihtoehtoa.

Kuva 24. Photoshopin (vas.) ja Indesignin varoitus, ettei avattavan tiedoston profiili vastaa työti-

lan profiilia
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”Use the embedded profile (instead of the working space)” säilyttää sisällytetyn profii-
lin ja käyttää sitä kaikissa muunnoksissa lähdeprofiilina. ”Convert document’s colors to 
the working space” muuntaa sisällytetyn profiilin työtilaprofiiliksi. Näillä kahdella edellä 
mainitulla vaihtoehdolla tiedostoa käsitellään profiloituna. ”Discard the embedded pro-
file (don’t color manage)” hylkää sisällytetyn profiilin, olettaa työtilaprofiilin ja käsittelee 
tiedostoa profiilittomana. (Fraser ym. 2004, 330.)

Kun ”Profile Mismatches” -kohdan ”Ask when pasting” -ruutu on valittuna (Kuva 23), 
sovellus varoittaa liitettävän objektin ristiriitaisesta profiilista ja antaa edellä esitellyt 
vaihtoehdot.

”Ask when opening” -ruutu valittuna kohdassa ”Missing Profiles” käskee varoittamaan, 
jos avattavaan tiedostoon ei ole sisällytetty profiilia, ja kuvan 25 kaltainen varoitusikku-
na ilmestyy. Tämäkin varoitusikkuna antaa kolme vaihtoehtoista toimintatapaa.

Kuva 25. Varoitus avattavan tiedoston profiilin puuttumisesta

”Leave as is (don’t color manage)” olettaa profiilittoman tiedoston profiiliksi työtilan 
profiilin ja käsittelee tiedostoa profiilittomana. ”Assign working RGB/CMYK” käsittelee 
tiedostoa profiloituna työtilaprofiililla. ”Assign Profile” antaa valita tiedostolle minkä 
tahansa väritilaan sopivan profiilin ja käsittelee sitä sen jälkeen profiloituna. Tällä vaih-
toehdolla voidaan myös tiedosto muuntaa valitusta profiilista työtilaprofiiliin asettamalla 
”and then convert document to working RGB/CMYK” valituksi. (Kuva 25.)

Profiilitonta tiedostoa avattaessa turvallisin vaihtoehto on ”Leave as is (don’t color 
manage)”. ”Assign”-komennot muuttavat tiedoston värejä, eikä esikatselu tässä koh-
taa ole mahdollinen. Profiili kannattaa määrittää vasta tiedoston avaamisen jälkeen. 
”Assign Profile”-toiminto (Edit>Assign Profile) antaa mahdollisuuden esikatsella tiedos-
toa valitulla profiililla. Joskus jokin profiili saattaa muuttaa tiedoston värejä hyvinkin 
radikaalisti.

Valitsemalla Photoshopin väriasetuksista ”More Options” ja Indesignin asetuksista 
merkitsemällä kohdan ”Advanced Mode” valituksi, ilmestyy vielä muutama asetus (Kuva 
26). 
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”Engine”-valikosta voidaan valita haluttu värinhallintamoduuli eli CMM-laskin (kts. 5.2.3) 
ja ”Intent”-valikosta haluttu muunnosalgoritmi (kts. 5.2.4). ”Use Black Point Compen-
sation” valinnalla varmistetaan, että ”lähteen musta kuvataan aina kohteen mustaksi” 
(Fraser ym. 2004, 335). Näitä kolmea edellä mainittua asetusta käsitellään tarkemmin 
luvussa 9. Photoshopin lisäasetuksissa on vielä ”Advanced Controls” -osio. ”Desaturate 
Monitor Colors By” -valinnalla voidaan vähentää näytöllä näkyvien värien kylläisyyttä 
haluttu prosenttimäärä. Valinta vaikuttaa ainoastaan Photoshopiin avattavien kuvien vä-
rien ilmiasuun, se ei vähennä koko näytön värikylläisyyttä. Se ei myöskään  vaikuta itse 
kuvatiedostoon. Voisi siis ajatella, että valinta luo värikylläisyyttä vähentävän suotimen, 
jonka läpi kuvat esitetään näytöllä. ”Blend RGB Colors Using Gamma” -valinta vaikuttaa 
siihen, mitä gamma-arvoa käytetään sekoitettaessa RGB-värejä. Näitä kahta lisävalin-
taa ei ole syytä pitää päällä, ellei ole täysin tietoinen niiden vaikutuksista ja varma, että 
niitä tarvitsee. (Kuva 26.)

Kuva 26. Photoshopin (vas.) ja Indesignin väriasetusten lisäasetukset
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9 VÄRIEN SÄÄTÖ VÄRIKOHTEEN AVULLA

Kun väriasetukset ovat kohdallaan, voidaan kuvat avata Photoshopiin värien säätöä 
varten. Seuraavissa kappaleissa käydään läpi sekä RAW- eli raakakuvan että JPG-ku-
van värien säätöä värikohteen avulla. Tarkoituksena ei ole esitellä kaikkia mahdollisia 
toimintoja värien säätöön, vaan esitellä yksi mahdollinen työnkulku kummallekin edellä 
mainitulle tiedostomuodolle.

Esimerkeissä käytettäväksi värikohteeksi on valittu Qpcard sen yksinkertaisuutensa 
sekä edullisuutensa vuoksi. Osa kuvassa 22 esitetyistä värikohteista maksaa jopa useita 
satoja euroja, mutta edullisellakin värikohteella päästään hyviin tuloksiin.

9.1 RAW

I. Työskentely aloitetaan avaamalla sekä lopullinen että värikohteen kanssa kuvattu RAW-kuva 

Photoshopiin. Kuvat avautuvat ”Camera Raw” -ikkunaan. Värikohteen kanssa kuvattu valokuva 

valitaan aktiiviseksi. Alareunassa olevaa tekstiä (esim. ”Adobe RGB (1998); 8 bit; 2336 by 3504 

(8,2 MP); 300 ppi”) klikkaamalla pääsee hallinnoimaan kuvan perusasetuksia.
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III. ”Workflow Options” -ikkunassa tehtyjen asetusten jälkeen säädetään kuvan valkotasapai-

noa työkalupalkista löytyvän harmaan pipettityökalun avulla. Klikkaamalla pipetillä värikohteen 

harmaata ruutua sovellus muuttaa klikattavan kohdan keskiharmaaksi ja muuttaa koko kuvan 

värisävyjä sen mukaan. Klikattava kohta tulisi olla keskellä harmaata ruutua, jotta vierekkäiset 

pikselit ovat samanvärisiä.

IV. ”Camera Raw” -ikkunan oikeassa reunassa olevista välilehdistä 

ensimmäinen on ”Basic”. Tämän välilehden avulla valokuvalle voidaan 

tehdä perus värinsäätöä. Koska se on välilehdistä tärkein, se käsitellään 

muita hieman tarkemmin. ”Temperature”- ja ”Tint”-säätimien avulla 

voidaan säätää käsin se, mikä edellisessä kohdassa tehtiin automaat-

tisesti värikohteen ja pipettityökalun avulla. Edellä mainituilla liuku-

säätimillä voidaan säätää siis valkotasapainoa. Kuvan huippuvaloihin 

voidaan vaikuttaa ”Exposure”-arvoa muuttamalla. Suositeltava muutos 

on +/- 2. Jos valokuvan jokin kohta on päässyt palamaan, vaaleaan 

päähän voidaan luoda lisää sävyjä ”Recovery”-säätimen avulla. Jos taas 

näyttää siltä, että musta on menossa tukkoon, avataan kuvan varjoja 

kasvattamalla ”Fill Light” -arvoa. ”Recovery”- ja ”Fill Light”-säätimiä 

tulee käyttää harkiten. Jos mustaa on tarve saada tummemmaksi, se 

onnistuu ”Blacks”-liukusäätimen avulla. ”Brightness”-arvoa säätämällä 

vaikutetaan valokuvan keskisävyihin. Kuvan kontrastia voi kasvattaa tai 

vähentää ”Contrast”-säätimellä. ”Clarity” vaikuttaa ääriviivojen kontras-

tiin. Kontrastia tulisi säätää vasta sen jälkeen kun valkoisen, harmaan 

ja mustan säädöt on tehty. Turvalliset toistettavat arvot ovat valkoiselle 

245 +/- 15 ja mustalle 40 +/- 15. Tällöin keskiharmaan tulisi olla 130 

+/- 10. Kontrastin kasvattaminen lisää värin kylläisyyttä, mutta sitä 

voidaan kompensoida ”Vibrance”- ja ”Saturation”-säätimillä.

II. Raakakuvalle voidaan määrittää haluttu väriprofiili ”Space”-valikosta. ”Depth”-valikko tar-

joaa mahdollisuuden bittisyvyyden valitsemiseen, yleisesti 8 bittiä/kanava on riittävä. Kuvan 

mittasuhteisiin voi vaikuttaa ”Size”-valikon avulla ja tulostusresoluutio voidaan määrittää käsin 

kohtaan ”Resolution”. Oletusasetuksina näissä kohdissa ovat Photoshopin oletusasetukset.



40

VI. Kolmannen ”Detail”-välilehden ”Sharpening”-osion säätimet antavat 

mahdollisuuden kuvan terävöittämiseen. Terävöityksen esikatselu ”Ca-

mera Raw” -ikkunassa vaatii kuvasta vähintään 100 % suurennoksen. 

Terävöitys voidaan tehdä tässä vaiheessa sovelluksen antamilla ole-

tusarvoilla. Vaihtoehtoisesti ”Amount”-arvoksi määritetään 0 ja kuvan 

terävöitys suoritetaan vasta kun se on avattu Photoshopiin. Jälkimmäi-

nen vaihtoehto tarjoaa paremmat mahdollisuudet terävöityksen esi-

katseluun. ”Noise Reduction” -osion säätimillä voidaan korjata kuvassa 

ilmenevää kohinaa.

VII. ”HSL/Grayscale”-välilehdellä olevat säätömahdollisuudet ovat 

käyttökelpoisia, jos värikuva muutetaan mustavalkoiseksi.

VIII. Huippuvalojen tai varjojen värivirheet voidaan korjata ”Split 

Toning”-välilehdellä.

V. ”Tone Curve” -välilehti tarjoaa vaihtoehtoisen keinon kontrastin 

muuttamiseen . Esimerkiksi ”Point”-välilehdellä olevasta ”Curves”-vali-

kosta löytyy valmiita käyriä. Oletusarvona on ”Medium Contrast”, joka 

on käyttökelpoinen sellaisenaan.
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IX. Jotkin objektiivit sävyttävät kuvan ääriviivoja. Tätä voidaan korjata ”Lens Corrections” -

välilehdellä ”Chromatic Aberration” -liukusäätimien avulla. ”Lens Vignetting” -säätimillä voidaan 

korjata, jos kuvan sävyt tummenevat kulmia kohti.

X. Jos kamera tuottaa kuvaan liikaa jotakin osaväriä, sitä voidaan 

korjata ”Camera Calibration” -välilehden säädöillä. Esimerkiksi jos 

punaisen määrä tietyllä kameralla otetuissa kuvissa on aina liian suuri, 

voidaan asetukset tallentaa viimeisellä ”Presets”-välilehdellä, jolloin 

samoja säätöjä ei tarvitse tehdä kerta toisensa jälkeen uudestaan.

XI. Kun tarvittavat säädöt ja korjaukset on 

tehty, valitaan ”Select All” -komennolla molem-

mat kuvat aktiivisiksi ja valitaan ”Synchronize”. 

Komento avaa ikkunan, jossa on mahdollisuus 

valita synkronoitavat säädöt. Hyväksymällä 

valinnat sovellus tekee värikohde-kuvalle teh-

dyt muutokset myös ilman kohdetta kuvatulle 

valokuvalle. Tämän jälkeen kuva voidaan avata 

Photoshopiin ”Open Image” -komennolla.
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XII. Kun kuva on avattu Photoshopiin, ensimmäisenä kannattaa luoda kuvasta kopiotaso ja 

valita tämä taso aktiiviseksi. Tekemällä muutokset kopiotasolle varmistetaan, että alkuperäi-

nen kuva säilyy, jos jokin toimenpide epäonnistuu. Kuvassa olevat mahdolliset kennoroskat on 

hyvä siistiä tässä vaiheessa. Tämän jälkeen kuva terävöitetään ”Unsharp Mask” -toiminnolla 

(Filter>Sharpen>Unsharp Mask).

XIII. Terävöittämisessä kannattaa lähteä liikkeelle arvoista Amount: 166, Radius: 0,6 ja 

Threshold: 6. Suositeltava ”Amount”-arvo on 100 – 200 ja ”Radius”-arvo 0,6 – 1,5.
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XIV. Kun terävöitys on tehty, voidaan kuva kääntää RGB-tilasta CMYK-tilaan ”Convert to Profile” 

-toiminnolla (Edit>Convert to Profile). Avautuvassa ikkunassa näkyy sen hetkinen profiili koh-

dassa ”Source Space” ja kohtaan ”Destination Space” määritetään se CMYK-profiili, johon kuva 

halutaan kääntää. ”Conversion Options” -osiossa määritetään haluttu CMM-laskin (”Engine”) ja 

muunnosalgoritmi (”Intent”). Oletuksena CMM-laskimeksi on Adobe (ACE) ja sitä ei ole tarpeen 

muuttaa, jos täsmälleen samoja muunnoksia ei ole tarpeen saada muissa kuin Adoben sovelluk-

sissa (Fraser ym 2004, 325). Muunnosalgoritmit esiteltiin kappaleessa 5.2.4 ja niiden vaikutuk-

set valokuvaan on esitetty kuvassa 27. Kuvat löytyvät myös liitteestä 6. ”Perceptual” ja ”Relative 

Colorimetric” ovat toimivat vaihtoehdot valokuvalle. ”Conversion Options” -osiossa on vielä 

kolme valintaruutua. ”Use Black Point Compensation” on syytä pitää valittuna, sillä se varmistaa, 

että ”lähteen musta kuvataan aina kohteen mustaksi” (Fraser ym. 2004, 335), kuten edellisessä 

luvussa todettiin. Käytännössä se tarkoittaa sitä, että kuvan varjojen yksityiskohdat säilyvät, 

vaikka kohteen musta piste olisi korkeampi kuin lähteen, ja vastaavasti jos kohteen musta 

piste on matalampi kuin lähteen, se estää lopputulosta näyttämästä haalistuneelta (Fraser ym. 

2004, 336). ”Use Dither”-valinnalla varmistetaan, ettei muunnos aiheuta kuvaan posterisaatiota. 

Valinta on suositeltavaa pitää päällä, ellei kyseessä ole tasasävyistä grafiikkaa. ”Flatten Image” 

-valinnalla sovellus yhdistää kuvan kaikki tasot yhdeksi.

XV. Ennen kuvan kääntämistä RGB-tilasta CMYK-tilaan kohdeprofiilin sekä käytettävän muun-

nosalgoritmin vaikutuksia voidaan esikatsella ”Proof Colors” -toiminnolla (View>Proof Colors). 

”Custom”-asetuksissa (View>Proof Setup>Custom) voidaan valita kohdeprofiili, sekä muun-

nosalgoritmi. Merkitsemällä kohdan ”Simulate Paper Color” sovellus simuloi paperin vaikutusta 

kuvan väreihin. ”Black Point Compensation” on hyvä pitää valittuna. Kun käytettävä profiili sekä 

muunnosalgoritmi on valittu ”Custom”-asetuksissa ”Gamut Warning” -toiminnolla (View>Gamut 

Warning) voidaan tarkastella toistoalueen ylittäviä värejä. Kun toiminto on päällä, kaikki ne 

kohdat, joiden värit ylittävät kohdeprofiilin toistoalan, merkitään harmaalla värillä. Aina jos mah-

dollista, on parempi pyrkiä itse säätämään kuvan värejä toistoalan sisään mahtuviksi, kuin antaa 

valitun muunnosalgoritmin muuttaa värejä.
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Kuva 27. Muunnosalgoritmien vaikutukset: A. Perceptual, B. Saturation, C. Relative Colorimetric, 

D. Absolute Colorimetric

A. B.

C. D.
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I. Kun värikohteen kanssa kuvattu JPG-kuva on avattu Photoshopiin työskentely aloitetaan 

luomalla kuvasta kopiotaso ja valitsemalla se aktiiviseksi. Tämän jälkeen työkalupalkista valitaan 

pipetti-työkalu ja sen otanta-alue (”Sample Size”) muutetaan yläreunan palkissa vähintään ”5 by 

5 Average”.

9.2 JPG

II. Valokuvan valkotasapianoa säädetään luomalla uusi ”Curves”-taso kuvan osoittamasta vali-

kosta. Avautuvasta ikkunasta valitaan harmaa pipettityökalu. Klikkaamalla pipetillä värikohteen 

harmaata ruutua, sovellus säätää kuvan valkotasapainoa samalla periaatteella kuin edellisessä 

luvussa esiteltiin (9.1, kohta III).
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III. Kun valkotasapaino on säädetty, luodaan uusi ”Levels”-taso samasta valikosta kuin ”Cur-

ves”-taso. ”Levels”-ikkunassa näkyy valokuvan sen hetkinen histogrammmi. ”Input Levels” 

-osiossa säädetään kuvan mustaa ja valkoista pistettä. Säätämällä mustan liukusäädintä pitäen 

samalla Alt-näppäintä pohjassa sovellus näyttää mustalla taustalla värillisinä ne kohdat, jotka 

ovat menossa tukkoon. Valkoista säätämällä, Alt-näppäin pohjassa, sovellus puolestaan näyttää 

valkoisella taustalla värillisenä ne kohdat, jotka ovat menossa puhki. Tavoitteena on, että histo-

grammi kulkisi reunasta reunaan.

IV. Jos haluaa hyödyntää sovelluksen automaatioita mustan ja valkoisen pisteen säätämiseen, 

”Levels”-ikkunan ”Options”-valinnan alta löytyvä ”Enhance Monochromatic Contrast” ilman 

”Snap Neutral Midtones” -valintaa on käyttökelpoinen valinta. Muuttamalla ”Target Colors & 

Clipping” -osion ”Shadows”-kohdan mustan Brightness-arvoa 4 %:iin ja ”Highlights”-kohdan 

valkoisen 96 %:iin, varmistetaan, ettei mikään kohta pääse palamaan tai menemään tukkoon. 

Värejä pääsee muuttamaan kaksoisklikkaamalla väriruutua.
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V. Mikäli ”Levels”-säädöt tuottavat liian radikaalin muutoksen, tason 

läpinäkyvyyttä säätämällä vaikutuksia voidaan pehmentää.

VI. ”Curves”- ja ”Levels”-säätöjen jälkeen avataan ilman värikohdetta 

otettu kuva Photoshopiin, ja luodaan jälleen kopiotaso. Tämän jälkeen 

siirrytään kuvaan värikohteen kanssa, ja valitaan sekä ”Curves”- että 

”Levels”-tasot aktiivisiksi. Raahaamalla tasot ilman värikohdetta ku-

vatun valokuvan päälle tasot kopioituvat. Tämän jälkeen työskentelyä 

jatketaan ilman värikohdetta kuvatun valokuvan kanssa, kopiotaso 

valittuna aktiiviseksi.

VII. Sekä kameran aiheuttamaa ääriviivojen sävyttymistä että sävyjen tummumista reunoille 

voidaan korjata ”Lens Correction” -toiminnolla (Filter>Distort>Lens Correction). Ääriviivojen 

sävykorjaus tapahtuu ”Chromatic Aberration” -liukusäätimien avulla, ja reunojen sävykorjaus 

”Vignette”-säätimillä.
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VIII. Ennen kuvan konvertointia CMYK-profiiliin muutetaan kuvan tulostusresoluutioksi 300  

”Image Size”-toiminnolla (Image>Image Size). Ennen arvon syöttämistä ”Resolution”-kohtaan 

tulee tarkistaa, että ”Resample Image” -valintaruutu ei ole valittuna. Tällöin tulostusresoluution 

muuttamisella ei vaikuteta kuvan mittasuhteisiin. Tämän jälkeen kuva voidaan kääntää CMYK-

profiiliin kuten RAW-kuva (9.1, kohta XIV).

IX. ”Camera Raw” -tilaan on mahdollista avata myös muita kuin RAW-tiedostomuotoja. Joten 

mikäli tämä käyttöliittymä miellyttää, voi myös esimerkiksi JPG-kuvan värisäädön tehdä ko. tilas-

sa. On syytä kuitenkin muistaa, että JPG-tiedosto on pakattua informaatiota ja osa informaatios-

ta on jo hukattu.
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9.3 RAW:n ja JPG:n eroja

Toisin kuin RAW-kuvaa, JPG-kuvaa ei tarvitse terävöittää, sillä kamera tekee sen jo 
kuvausvaiheessa. Sen määrän voi asettaa kameran asetuksissa. RAW- ja JPG-kuvan 
terävyyden erot voi havaita kuvasta 28. Kuvat ovat suoraan kamerasta.

Kuva 28. JPG-kuvan (vas.) ja RAW-kuvan ero terävyydessä

JPG-formaatti pakkaa kuvatiedostoa hyvin paljon, mistä syystä JPG-tiedoston koko voi 
olla jopa viisi kertaa pienempi kuin RAW-tiedoston. Kypäräkuvien JPG-tiedostot olivat 
kooltaan keskimäärin 2,2 Mt ja RAW-tiedostot 7,1 Mt. Koska JPG-formaatti hukkaa osan 
kuvatiedosta, esimerkiksi kypäräkuvissa osa kiiltojen sävyistä hukkuu (Kuva 29).

Kuva 29. Vasemmalla olevien JPG-kuvien kiiltojen sävyerot ovat huomattavasti pienemmät kuin 

oikealla olevien RAW-kuvien
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10 PAINOVALMIIN MATERIAALIN TOIMITTAMINEN

Painovalmis materiaali toimitetaan painoon yhä useammin PDF-muodossa. PDF (Por-
table Document Format) on yksi yleisimmin käytetyistä sähköisistä tiedostomuodois-
ta ja se hyväksyttiin ISO-standardiksi vuonna 2008 (International Organization for 
Standardization). 

10.1 PDF

Aiemmin PDF:n luontia ei suositeltu tehtäväksi suoraan Indesignista, vaan Adobe Distil-
ler -ohjelman avulla, sillä suoraan Indesignista luotujen PDF-tiedostojen kanssa ilmeni 
ongelmia. Ongelmia olivat muun muassa fonttien katoaminen sekä liukuvärien posteri-
saatio. Joidenkin lähteiden mukaan CS- ja sitä uudemmilla versioilla PDF:n tekeminen 
on turvallista suoraan Indesignista. Joidenkin lähteiden mukaan vasta CS2-versiolla ja 
sitä uudemmilla versioilla suoraan Indesignista tehtyjen PDF-tiedostojen kanssa aiem-
min kuvattuja ongelmia ei ole, sillä ne käyttävät samaa PDF-moottoria kuin Distiller. 
Myös eri painot antavat erilaisia ohjeita tähän; osa ohjeistaa tekemään PDF:n suoraan 
Indesignista CS-versiosta, osa CS2-versiosta eteenpäin. Näiden tietojen pohjalta voisi 
todeta, että Indesign CS2:lla ja sitä uudemmilla versioilla PDF-tiedosto voidaan tehdä 
suoraan ”Export”-komennon avulla (File>Export). Tiedoston nimeämisen jälkeen avau-
tuvan ”Export Adobe PDF” -ikkunan ”Adobe PDF Preset” -pudotusvalikossa on valmiita 
esiasetuksia (Kuva 30). 

Kuva 30. Indesignin ”Export Adobe PDF” -ikkunan ”General”-näkymä

Useiden painojen kotisivuilla on ladattavissa valmiita PDF-esiasetuksia, jotka voidaan 
ladata Indesigniin (File>Adobe PDF Presets>Define>Load). Omia esiasetuksia voidaan 
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tallentaa lähes saman polun kautta (File>Adobe PDF Presets>Define>New) tai ”Export 
Adobe PDF” -ikkunassa ”Save Preset” -komennolla. Indesign CS3:sta löytyy valmiina 
kuusi esiasetusta. ”High Quality Print” on tarkoitettu tarkkuustulostukseen vedostuslait-
teilla tai työpöytätulostimilla, ”Press Quality” laadukasta tulostusta varten ja ”Smallest 
File Size” www-ympäristöön sekä sähköpostin liitteenä käytettäväksi tiedostoksi. Muut 
kolme vaihtoehtoa esitellään seuraavassa. 

PDF/X on graafiseen tarkoitukseen luotu kooste PDF-tiedostomuodosta. Siitä on jätetty 
kaikki painokäytön kannalta turhat asiat pois, kuten multimediaan liittyvät toiminnot. 
(Gardberg 2007.) 

PDF/X-1a:2001 on tarkoitettu ”painovalmiissa muodossa olevan tulostusdatan ’sokeaksi 
siirroksi’; PDF sisältää itsessään kaikki tulostuksessa tarvittavat elementit” (Fraser ym. 
2004, 401). Värit pakotetaan dokumentin CMYK- ja/tai spottiväreiksi ja mahdolliset läpi-
näkyvyydet litistetään pois (Gardberg 2007).

PDF/X-3:2002 vastaa PDF/X-1a:2001:sta, mutta se voi sisältää myös RGB- että Lab 
värejä (Blatner & Kvern 2009; Gardberg 2007). 

PDF/X-4:2007 on uusin PDF/X-kooste joka on samankaltainen PDF/X-3:2002:n kanssa. 
Ero näiden kahden välillä on siinä, että PDF/X-4:2007 säilyttää läpinäkyvyyden (Blatner 
& Kvern 2009; Gardberg 2007).

10.2 Kuviin vaikuttavat PDF-asetukset

Seuraavassa on esitelty lyhyesti valokuviin ja niiden väreihin vaikuttavat ”Export Adobe 
PDF” -asetukset.

Mikäli taittotiedostoon tuodaan kuva, jonka resoluutio on 300 ppi ja se pienennetään 
50%:iin alkuperäisestä, kuvan resoluutio kasvaa 600 ppi:iin. Export-asetuksissa voi-
daan Indesignia pyytää pienentämään esimerkiksi yli 450 ppi:n kuvat 300 ppi:n ku-
viksi. Pienennys tapahtuu muuttamalla alue pikseleitä yhdeksi suuremmaksi pikseliksi. 
Indesign tarjoaa tähän toimintoon kolme eri vaihtoehtoa. ”Average Downsampling to” 
-valinnalla Indesign laskee alueella olevien pikseleiden värien keskiarvon uuden pikselin 
väriksi. ”Subsampling to” -valinnalla uuden pikselin väriksi määräytyy alueen keskim-
mäisen pikselin väri. Kolmas ”Bicubic Downsampling to” -vaihtoehto antaa tasaisimman 
lopputuloksen, sillä se laskee uuden pikselin värin alueen pikseleistä käyttäen paino-
tettua keskiarvoa, ja on suositelluin näistä kolmesta vaihtoehdosta. Paras vaihtoehto 
kuitenkin on muuttaa kuva oikeaan kokoon Photoshopissa ja valita Export-asetuksissa 
”Do Not Downsample”. (Blatner & Kvern 2009.) (Kuva 31.)
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Väri- ja harmaasävykuvien pakkaamiseen on valittavana seuraavat vaihtoehdot: None, 
Automatic (JPEG), JPEG, ZIP, JPEG 2000, Automatic (JPEG 2000). 1-värikuville vastaa-
vat vaihtoehdot ovat: None, CCITT Group 3, CCITT Group 4, ZIP, Run Length. JPEG 
2000 on mahdollista valita vain jos yhteensopivuudeksi (”Compatibility”) on valittu 
Acrobat 6 tai uudempi. Koska JPEG-pakkaus hävittää informaatioita, paras vaihtoehto 
väri- ja harmaasävykuville on ZIP, mikäli tiedoston suuruudella ei ole merkitystä. Mutta 
mikäli tiedoston tulee olla niin pieni kuin mahdollista, on järkevä vaihtoehto ”Automatic 
(JPEG) ”Maximum” ”Image Quality” -valinnalla. Tai jos tiedossa on, että vastaanottajal-
la on käytössään Acrobat 6 tai uudempi, vaihtoehtoisesti voi käyttää parempilaatuista 
JPEG 2000 -pakkausta. 1-värikuvien kohdalla pakkausvaihtoehtojen tuottamissa loppu-
tuloksissa ei juurikaan ole eroa. (Blatner & Kvern 2009.) (Kuva 31.)

”Compress Text and Line Art” -ruutu valittuna (Kuva 31) kaikki tekstit ja viivakuvitukset 
pakataan, eikä ole mitään syytä, minkä takia tämä ruutu olisi syytä jättää ilman valin-
taa. ”Crop Image Data To Frames” -valinnalla (Kuva 31) Indesign rajaa kuvatiedostoista 
vain kuvakehyksissä näkyvät osat mukaan ja jättää näkymättömät osat pois. Tämä pie-
nentää PDF-tiedoston kokoa ja on useimmiten järkevä valinta. Mutta jos taittotiedosto 
sisältää sivun reunan yli meneviä kuvia, kannattaa valinta jättää pois, jotta tarvittaessa 
esimerkiksi leikkuuvarojen kasvattaminen on mahdollista. (Blatner & Kvern 2009.)

”Output”-näkymässä voidaan määritellä, kuinka tiedoston värejä käsitellään PDF-tie-
dostoa tehdessä. ”Colour Conversion” -kohdan ”No Colour Conversion” -valinnalla 
väreille ei tehdä mitään, RGB-värit pysyvät RGB-väreinä ja CMYK-värit CMYK-väreinä. 
Tämä on mahdollista siis silloin, jos käytössä on joko PDF/X-3 tai PDF/X-4. Sekä ”Con-
vert to Destination” - että ”Convert to Destination (Preserve Numbers)” -valinnalla 
kaikki RGB-värit konvertoidaan ”Destination”-kohdassa valittuun kohdeprofiiliin. ”Con-
vert to Destination” konvertoi myös kaikki CMYK-värit kohdeprofiiliin, mutta ”Convert to 

Kuva 31. Indesignin ”Export Adobe PDF” -ikkunan ”Compression”-näkymä
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”Profile Inclusion Policy” -valikosta voidaan valita, sisällytetäänkö PDF-tiedostoon väri-
profiilia vai ei. Värinhallitussa työnkulussa on luonnollisesti tärkeää, että väriprofiili on 
mukana. ”Simulate Overprint” on tarkoitettu ainoastaan koevedoksen katseluun ja pai-
novalmiissa materiaalissa se ei saa koskaan olla käytössä. ”Ink Manager” -toimintojen 
avulla voidaan esimerkiksi spottivärit muuntaa prosessiväreiksi. (Blatner & Kvern 2009.) 
(Kuva 33.)

Kuva 32. Indesignin ”Export Adobe PDF” -ikkunan ”Output”-näkymä

Destination (Preserve Numbers)” konvertoi ainoastaan ne CMYK-värit, joiden profiili ei 
ole sama kuin kohdeprofiili. Tällä valinnalla Indesignissa määritelly värit, kuten tekstin 
värit, pysyvät muuttumattomina, joka estää muun muassa sen, ettei tekstin 100-pro-
senttinen musta muutu 4-väri mustaksi. (Blatner & Kvern 2009.) (Kuva 32.)

Kuva 33. ”Ink Manager” -ikkunassa voidaan spottivärit muuntaa prosessiväreiksi
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Kuva 34. ”Preflight”-ikkunan yhteenvedossa näkyy varoitus yhden kuvan puuttumisesta

10.3 Avoin tiedosto

Painovalmis materiaali voidaan toimittaa painoon myös niin sanottuna avoimena tie-
dostona. Valmis taittotiedosto pakataan ”Package”-toiminnolla (File>Package), jolloin 
sovellus kerää sekä taittotiedoston, sijoitetut kuvat että käytetyt fontit yhteen kansioon. 
Ennen pakkaamista on kuitenkin hyvä tarkistaa ”Preflight”-toiminnolla (File>Preflight), 
että taittotiedosto on kunnossa, eikä esimerkiksi sijoitettujen kuvien linkityksissä ole 
virheitä. Mikäli esimerkiksi jokin linkitetty kuva puuttuu, ”Preflight”-ikkunassa näkyy 
varoituskolmio sekä tieto ongelmasta (Kuva 34). Tarkempia tietoja puuttuvasta kuvasta 
saa ”Links and Images” -kohdasta. Mahdollisten ongelmien korjaamisen jälkeen voi-
daan pakkaaminen aloittaa suoraan ”Preflight”-ikkunasta ”Package”-komennolla.
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11 lopuksi

Esimerkkikuvissa käytetty kypärä-kuva julkaistiin Bike-lehden numerossa 2/09. Käy-
tettäväksi kuvaksi valitsin valokuvan, joka kuvattiin halogeenivalaistuksessa. Värit 
säädettiin luvussa 9.1 esitellyllä tavalla. Valkotasapainon säätämisen lisäksi ei kuval-
le tarvinnut juurikaan tehdä muita värien säätöjä, sillä säädöt ja asetukset tehtiin jo 
kuvaustilanteessa tarkasti. Ennen kuvan viemistä taittotiedostoon, kypärä syvättiin 
taustasta. Lehti toimitettiin painoon PDF-tiedostoina. Sivu, jolla kuva julkaistiin löytyy 
liitteenä (Liite 7).

Tämä prosessi osoitti käytännössä sen, että painettuna kuva ei ole täysin identtinen 
sen kanssa, miten kuvattava kohde nähdään kuvaushetkellä. Kuva ei ole painettuna 
myöskään täysin samanlainen kuin miltä se näyttää näytöltä katseltuna, sillä värit 
muodostuvat näytöllä ja paperilla eri tavalla. Matkalla, jonka kuva kulkee kuvaushetkes-
tä esimerkiksi lehden sivulle, on useita yksittäisiä tekijöitä, jotka vaikuttavat tai voivat 
vaikuttaa valokuvan väreihin. Jo pelkästään se, että kamerat toistavat värejä yksilölli-
sesti, vaikuttaa lopputulokseen – jos värejä tarkasteltaisiin erittäin tarkasti, jopa saman 
merkkisten, saman mallisten ja saman ikäisten kameroiden tuottamissa väreissä olisi 
hienoisia eroja. Avattaessa kuvaa esimerkiksi Photoshopiin, yksi väärä asetus tai väärä 
napin painallus, voi muuttaa valokuvan värejä, joissain tapauksissa radikaalistikin. 

Lopullisen painetun kuvan ilmiasuun vaikuttavat vielä painotekniset ominaisuudet, ku-
ten rasterointitapa, linjatiheys sekä paperin laatu. Pisteenkasvu, eli rasteripisteen leviä-
minen paperiin painettaessa, on myös yksi vaikuttava tekijä painettuun lopputulokseen. 

Parhaaseen mahdolliseen lopputulokseen päästään hallitulla ja standardoidulla työn-
kululla. Tämä tarkoittaa siis sitä, että kaikki työvaiheet tulee tehdä hallitusti, käyttää 
standardien mukaisia väriprofiileja, sekä painoja jotka käyttävät niitä. Värinhallitusta 
työnkulusta ei juurikaan ole hyötyä, jos aineisto painetaan sellaisessa painossa, joka ei 
noudata standardin mukaista työnkulkua.

Loppuyhteenvetona voisi todeta, että vaikka värinhallinta saattaa vaikuttaa hyvin 
vaikealta ja monimutkaiselta asialta, ei se käytännössä tarvitse hankalia toimenpiteitä. 
Aiheeseen perehtymistä se toki tarvitsee ja tärkeintä värinhallitussa työnkulussa onkin 
tietää mitä tekee ja ennen kaikkea miksi niin tekee. 
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